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KnowlitAll Software Training
Simple Spectral Search/Identification with KnowltAll ID Expert
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Simple Spectral Search/ldentification

How to Use KnowltAll ID Expert to Perform a Simple Spectral Search/ldentification

Purpose

These exercises demonstrate how to use KnowltAll ID Expert to identify IR, Raman, and other spectra.

Objectives

These exercises will teach you:

» How to perform single component searches, multiple component searches, designer drug classification & functional group analyses simultaneously, and
view results on a single screen for complete view of all possibilities for the unknown spectrum

» How to deconvolve industrial material to organic chemicals, inorganic chemicals, and component chemicals
» How KnowiltAll ID Expert’s patented optimized corrections technology can help you find the optimal search results

How to generate a PDF report with a single click

Background
Training Files Used in This Lesson
The KnowltAll ID Expert spectral identification software combined with the KnowltAll Spectral C:\Users\Public\Documents\Wiley\KnowltAl\Samples
Libraries provide fast answers for scientists identifying unknown spectra. e \ID Expert\IR\2 - ATR-IR of Unknown Sample
8675309.irf
It's easy to use. Simply open an unknown spectrum and KnowltAll ID Expert automatically » \ID Expert\IR\ - ATR-IR of Unknown Sample
performs single component searches, multiple component searches, possible designer drug 1282013.irf

classification and functional group analyses simultaneously, and summarizes the results on a * \Deformulation\Deformulation Example.irf

single screen to give a complete view of all possibilities for the unknown. It can also perform ¢ \Optimized Corrections\Raman Spectrum of
analysis using only pure organic and inorganic compound spectra, thus breaking down industrial Mint Candy.wdf

material into basic building blocks. If there are problems with the query spectrum, ID Expert has the KnowltAll Applications Used

spectral intelligence to identify issues and fix them using patented Optimized Corrections. Once the e KnowltAll ID Expert

user has identified the unknown spectrum, a PDF report can be generated with a single click.
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KnowltAll IR and Raman Search Algorithms

A background in the algorithms used by KnowltAll will be beneficial. For IR and Raman spectral comparison, KnowltAll uses the following
algorithms:

Correlation

This is the default algorithm for searching in KnowltAll and it conforms to the industry standard for correlation algorithms. The Correlation algorithm
is similar to the Euclidean Distance algorithm. The difference between the two is in the way the spectra are treated before the comparison. Each
spectrum is mean-centered prior to performing the dot product normalization. This approach can improve search results for noisy spectra and
spectra that have baseline issues, particularly with a baseline offset that is the result of a negative spike or chemical noise. It is slightly more time-
consuming than the Euclidean Distance algorithm. The search speed is slower because each spectrum in the database must be mean centered
and then normalized prior to the comparison. The search results that are obtained with the Correlation algorithm are spectrally similar to the
unknown, even if the unknown compound is not in the database. The Correlation algorithm is heavily weighted by peak areas. Broad features are
weighted much more strongly than sharp features. The algorithm is most tolerant to peak shifts and non-linearities in relative band intensities.

Correlation (Classic)

The Correlation algorithm that was found in all versions of KnowltAll prior to KnowltAll 2020 is similar to the Euclidean Distance algorithm.
However, it did not conform to the industry standard for correlation algorithms. Beginning with KnowltAll 2020, the Correlation algorithm does
conform to the industry standard and it is the default algorithm used for searching in KnowltAll. To provide backward compatibility for customers
who want to reproduce prior search results, the previous correlation algorithm is now provided as Correlation (Classic).

Euclidean Distance

The Euclidean Distance algorithm measures the point-to-point differences between a pair of spectra. The results that are obtained with

the Euclidean Distance algorithm are spectrally similar to the unknown, even if the unknown compound is not in the database. This algorithm,
however, can yield degraded search results when the unknown spectrum has a sloping or offset baseline. The Euclidean Distance algorithm is
heavily weighted by peak areas. Broad features are weighed much more strongly than sharp features. This algorithm is most tolerant to peak
shifts and non-linearities in relative band intensities.

First Derivative Euclidean Distance

Use this algorithm to reduce the effects of baseline slope or offset in the unknown. Although search speed is slightly slower than with

the Euclidean Distance algorithm, the First Derivative Euclidean Distance sometimes gives improved search results, especially when the unknown
spectrum is a mixture of two or more compounds. The First Derivative Euclidean Distance algorithm is heavily weighted by changes in slope.
Sharp features are weighted much more strongly than broad features. The algorithm is also very sensitive to peak shifts. Small shifts can make
the algorithm miss a similar result.
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Second Derivative Euclidean Distance Use the Second Derivative Euclidean Distance algorithm to compare the second derivative of a
reference spectrum to that of the query spectrum.

Optimized Corrections: A Breakthrough Technology for Spectral Searching

Spectral searching is one of the most important tools scientists use to classify or identify materials, yet it continues to be plagued by errors and
imperfections. During a spectral search, a sample spectrum is compared to a database of reference spectra. To ensure that an optimal match is
found in the database, spectra can be adjusted to compensate for differences between spectra caused by variability in instruments, accessories,
environmental conditions, and other factors.

According to ASTM's guide on spectral searching', various algorithms and manual methods exist to adjust spectra to get reasonable match scores
when two compared spectra of the same compound differ for various reasons. While these methods may work in selected cases, subtle
discrepancies such as a shift of the X-axis are very hard to identify and correct manually. The inflexible mathematical algorithms typically
employed do not compensate for these types of errors in spectra that are flawed.

Manual corrections can be made by expert spectroscopists, but those less experienced in spectroscopy are often unaware of how to perform the
necessary corrections on their sample spectrum to achieve the best search result. To address this growing concern, Wiley has introduced
Optimized Corrections, a breakthrough patented technology that performs a computationally complex set of multiple corrections on query and
reference spectra in a search to find the optimal match between the query and each individual reference spectrum. This training guide will
demonstrate how the Optimized Corrections technology yields better match between query and reference spectra than can be attained using rigid
search algorithms alone or with manual methods to optimize spectra for searching.

Optimized Corrections consider the full spectrum during a selected range(s) search.

1TE2310-04 - Standard Guide for Use of Spectral Searching by Curve Matching Algorithms with Data Recorded Using Mid-Infrared Spectroscopy,
2009. ASTM International Web Site. http://www.astm.org/Standards/E2310.htm (accessed March 4, 2015).
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Example 1: 2 - ATR-IR of Unknown Sample 8675309.irf

Action

Result

Expert application by clicking the ID Expert
icon. Alternatively, if the desktop (standalone)
application is installed, ID Expert can be
opened directly by double-clicking on the
desktop icon.

1 Navigate to the Data toolbox and open the ID | The application opens and a Windows Open dialog box displays.
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Action

Result

2 Close the Open dialog box, then choose File
> Settings.

The Settings form opens.

General Qptimized Corrections Databases Classification
Algorithm: All Techniques Other Than MS: Correlation

MS: Dot-Product (Cosine)

. Remove Duplicates
. Remove Replicates

B Display Include/Exclude Ranges Selection Bars

Report Paper Size and Orientation: Letter - Portrait 2

Folder for Reports:  C:\Users\Public\Documents\Wiley\KnowltAl\Reports\ID Expert\

Peak Search Tolerance: IR v 16 cm™’

0 Display Peak Picking Threshold Control

Reset to Default

Browse...
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Action

Result

3 Select the Optimized Corrections tab.

1

Settings
General Optimized Corrections Databases Classification
Technique: IR e

Optimized Corrections

3 Enabled
. Baseline
B Vertical Clipping
[ ] Intensity Distortion
. Horizontal Offset
. Vertical Offset
B ATR Correction Adjustment

B ATR Correction Polarization

Cancel Apply

By default, Optimized Corrections is enabled for IR, Near IR, Raman, and NMR spectra. With the
Optimized Corrections checkbox enabled, you can specify which corrections you wish to apply for each
spectral technique.

4 Enable all Optimized Corrections for IR.
Click OK.

The Settings form closes.
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[ JImported spectrum is

Action Result
5 | Click New Search in the middle left of the window. & open
Look in | IR V| Qrrm-
Navigate to N ~ o 4
C:\Users\Public\Documents\Wiley\KnowltAll\Sa N ame ate mo
mples\ID Expert\IR folder Home &1 - IR of Unknown Sample 5021961 10/6/2023
B &2 - ATR-IR of Unknown Sample 8675309 10/6/2023
‘ &3 - ATR-IR of Unknown Sample 1261966 10/6/2023
3ssel7e5(§029--§TR-lR of Unknown Sample Desktop &4 - ATR-IR of Unknown Sample 1282013 10/6/2023
ATt &5 - ATR-IR of Unknown Sample 09071995 10/6/2023
‘Imported spectrum is’ should be checked. Choose Rl
ATR-IR from the dropdown menu. ]
This PC
Click Open. h
Network
File name: ‘2 - ATR-IR of Unknown Sample 8675309 v Open
Files of type: All Files (*%) ~ Cancel

2 - ATR-IR of Unknown Sample 86753 |

[y T

t, ML

AT L
. VA

N W

4000 3500

Encoding: <default>

2000 1500 1000 500

cm™?

3000 2500

108658-REV20250813 Copyright ©2025 by John Wiley & Sons, Inc. All rights reserved.

WILEY



H KnowltAll Training

Simple Spectral Search -9

Action

Result

6 | Wait for Search Status bars to show that the
search is complete.

The search proceeds automatically.

Query Status DWX #971; Methandriol (Corracted)
0.6~ - 2-ATR-IR of Unknown Sample 8675309 (Corrected)
Checklist Status Fix? 1
Noise @ @ (m] 054
Contaminants @ @
Technique @ @ | ATRIR ~ 0.4
© All Compounds O Pure Compounds E V‘
() Use Computed Spectra 0.3+ l
E i
e 5 |
Optimized Corrections 024 " | ll\ﬁ
V
Baseline of Query, Baseline of Reference, Intensity ® /\ \
Distortion, Vertical Clipping, Vertical Offset 0.14 N J \
g \\\W

EXCLUDE RANGE BAR

A

T !\ |

N Mﬂ "
) \MNU,M.VAMJ’J i ‘J I MMJU JM

4000 ' 3800 ' 3600 ' 3400 = 3200 = 3000 2800 = 2600 = 2400
[) New Search

2200 * 2000
cm™

INCLUDE RANGE BAR

1800

1600 1400 ~ 1200 ' 1000 = 8o’ edo ' 4do

Search Status 1-Component Results ‘ Peak Results ‘ Functional Groups ‘

Score ¥/ Infd Name

1 a Methandriol
2

@ (SOPROPYLAMINO)ETHAN ‘\,,'AA'\
oL

_/\/k‘/ﬂv‘&lw\
(@ LACTOSEINOSITOL (1:1) M
(@ POTASSIUM ANTIMONATE /\/L_\/\J/

4 \/

1-Component Results:
Top Hit: 96.5%

2-Component Results:

Click to Continue Searching
2 8584
Classifications:

No Hits Found STANOZOLOL IN KBr (MP
3 8452 (D) 2310) EtOH EXTRACT
Peak Results: WINSTROL
Top Hit: 93.8%

Functional Groups: 4 8439

49 Functional Groups Found

5 8421

6 8414 (@ LEMOL24-98

Create Report

N

KISB(OH)E]

The Score is the Hit Quality Index (HQI) in 100% unit — a comparison of reference spectrum to query

spectrum.

Note: Hit list might be different due to continuous addition of reference data.

7 | If SmartSpectra IR data is included in one’s
license, it can be selected by clicking Use
Computed Spectra so that licensed SmartSpectra
data is also searched.

Deselect Use Computed Spectra for this example.

Query Status

Checklist Status Fix?
Noise @ @ 0
@ ®

Technique . @

O Al Compounds

Contaminants

ATR-IR a4

O Pure Compounds

8 Use Computed Spectra

108658-REV20250813 Copyright ©2025 by John Wiley & Sons, Inc. All rights reserved.

WILEY



H KnowltAll Training Simple Spectral Search - 10 ||

Action Result

8 | Click the information icon @ in the main window’s | The Optimized Corrections window opens.
Optimized Corrections section. FEI p—— s

Scroll down to view information about the Optlmized Corrections

optimized corrections that were applied.

The following corrections were applied to the query and/or reference spectrum to get optimal results:

1

Close the window when you have finished
reviewing the information. The baseline of the query spectrum was corrected

The baseline correction is an automatic algorithm that tries to find points in the baseline and connects them through
lines. The intensity values of the spectrum are then subtracted from the intensity values of the lines to produce the
corrected spectrum.

—=1 —Corrected

4 —Uncorrected

4000 3500 3000 2500 2000 1500 1000 500
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Note: one can view the metadata of query spectrum by View > Query Spectrum Info |

View License Help
Absorbance
% Transmittance

X-Axis Format

Active Peaks
All Peaks

| ¥ Standard Toolbar
¥ Spectrum Toolbar
| v Status Bar

| Query Spectrum Info

>

Ctrl+K
Ctrl+Q

108658-REV20250813 Copyright ©2025 by John Wiley & Sons, Inc. All rights reserved.

WILEY



KnowltAll Training Simple Spectral Search - 12 ||

Example 2: 4 - ATR-IR of Unknown Sample 1282013.irf

Action Result

1 | Click New Search. A Windows Open dialog box displays.

2 | Navigate to The search proceeds automatically.

C:\Users\Public\Documents\Wiley\KnowltAINSa | There is no excellent 1-Component match, and KnowltAll ID Expert automatically examines multiple
mples\ID Expert\IR. component matches.

Open the spectral file 4-ATR-IR of Unknown
Sample 1282013.irf.

3 | Allow the search to complete. The 2-Component Results tab under Search Status flashes indicating that a good match has been
found.
4 | Click the 2-Component Results tab. The Composite Spectrum, individual component spectra, and Residual Spectrum are displayed.
EXCLUDE RANGE BAR
Query Status 1~ Composite Spectrum (Corrected)
— 4~ ATRR of Unknown Sample 1282013 (Corrected)
Checklist Status Fix?

Noise @ ® 0 s

Contaminants @ 6]

Technique @ @ |ATR-IR v 1
0.6

© All Compounds O Pure Compounds | 4 |

[J Use Computed Spectra | ‘ n "

0.4 ’

Optimized Corrections ] | ‘ \ rL\ h \k ‘ \ ’ |

Baseline of Query, Vertical Clipping, Vertical Offset (0] 0.2-] 0 K {l\ wﬂ‘ Ml‘ \A‘( | r | ﬂ “‘ ‘\»ﬂ
’ i | I | N Ww |l Jm Y \J\M
R J AN J S~ ) \\J W MJU W

4000 ' 3800 3600 ' 34b0 ' 3200 ' 3000 ' 2800 ' 2600 = 2400 2200 ' 2000 ' 1800 1600 ' 1400 ' 1200 ' 1000  8bo ' ‘edo” ' 'ado
D) New Searc -
b INCLUDE RANGE BAR
Search Status 1-Component Results 2-Component Results ‘ Classifications ‘ Peak Results | Functional Groups ‘

Score ¥ InfcRatio % Name % Chemical Structure Spectrum <auto> (IR/ATR-IR)
1-Component Results:
Top Hit: 78.1
ReHILIERS 1 95.48 NA. |Composite Spectrum

2-Component Results

Top Hit: 95.5% .
@ 062 Ethisterone ngtﬁ‘
3-Component Results:

Click to Continue Searching

@ 038  Epiandrosterone d?j
Classifications: \ N,

Top Hit: 100.0%

Peak Results: NA.  Residual Spectrum

Top Hit: 83.3% e

Functional Groups: 2 9012 NA.  Composite Spectrum 1:’(5;5’ L/J{j;b' U‘
115 Functional Groups Found : A,J'J\_;MEJ
@ 063 Ethisterone &Bd;f' MULW

Create Report
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Action Result

5 | Click the Classification tab. 1-Component Results 2-Component Results  Classifications | Peak Results | Functional Groups

Group Class Score [%]

Designer Drugs Steroids and related compounds 100.0

We can see that this sample is correctly classified by the predictive models in KnowltAll.
6 | Click Create Report in Search Status section. The Add Comments dialog box opens.

8 Add Comments X

Please enter any text that you would like to add to your report:

7 | Click OK. The report is created and automatically opens.
WILEY 2/21/2023 3:58 PM
Composite Spectrum (Corrected) M
~ Unknown Sample 1282013 (Corrected)
0.75—: M
] |
05— [ .
| Ll A
| ML’/ S JUW A i,
o4 S N o~ N \ I
40100 35IOO 3OI00 25100 20100 1 5IOO 1 0]00 5(1)0
cm™

Manual Corrections: None
Ranges: Full
Search Algorithm: Correlation

Query Path: C:\Users\Public\Documents\Wiley\KnowItAl\Samples\KnowItAll_2023_Example_Training_Files\02 - Simple
Spectral Search\ID Expert - IR\4 - ATR-IR of Unknown Sample 1282013.irf

Score [Info| Ratio Name Chemical Structure Spectrum

95.48 N.A. Composite Spectrum MMM
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Example 3: Deformulation Example.irf

Action Result

1 | Click the All Compounds radio button in the A Windows Open dialog box displays.
Query Status section.

(Depending on the previous action taken in ID
Expert, the start page may differ. If you do not see
the All Compounds radio button, close and
reopen KnowltAll, then navigate to ID Expert and
close the Open dialog box. You will then be able
to select All Compounds.)

Click New Search.

2 | Navigate to The search proceeds automatically.
C:\Users\Public\Documents\Wiley\KnowlItAll\Sa

mples\Deformulation. A perfect match is found: AKOLOUN S223-HM8. However, it is unclear what this material is made of.

Select Deformulation Example.irf.

Click Open.

3 | Click the radio button Pure Compounds. ID Expert performs another search, but only on pure organic and inorganic chemical spectra.

The 2-Component Results tab under Search Status flashes indicating that a good match has been
found.

108658-REV20250813 Copyright ©2025 by John Wiley & Sons, Inc. All rights reserved.

WILEY



H KnowltAll Training

Simple Spectral Search -15

Action

Result

4 | Click the 2-Component Results tab.

The Composite Spectrum, individual chemical component spectra, and Residual Spectrum are
displayed. The sample is possibly made up of NYLON and Calcium salt.

B ool nformars System 202, ChemWindow Eitin - x
Fll £t View Lcense Help

- =~ Tonser o OReporit Gysearcnit Cpvinen Databse ¥ QC xpert processic Chanayztt

Aepiestins +3 |D EXpert

Basics
Data

1D Expert

Searchit

Minelt/Craate

v

acepert

&

Assignit NMR

Spectrl Processing
Spectral Analysis

ERPE h+t LLH

Jo bk Ll 5 Al

i,

Query Status

[ checkist | s [ we
Noise ) @ 5]
Contaminents ® ® Fx
Tecwiae @ ® [

OAll Compounds @ Pure Compounds.

Optimized Corrections

Intensity Distortion, VerticalClipping

[ New Search

Search Status

1-Component Results:
Top Hit:67.4%

2-Component Results:
Top Hit: 958%

3-Component Results:
Click o Continue Searching

Peak Results:
Top Hit: 882%

Functional Groups:
33 Functional Groups Found

08 | \‘
‘\
— [ |
06 l |
| |
04— |
| 1
02+ | \ \
[\ \
]\ A A /o
P ~~_ "\ A M
od R S I S
— T T —
4000 3800 3600 3400 3200 3000 2800 2600 2400 2200 2000 1800 1600 1400 1200 1000 860
em™

INCLUDE RANGE BAR

1-Component Results  2-Component Results | Peak Results | Functional Groups |
% score Yo Ratio ChemicalStructure Spoctrum <auto> (R/ATRIR) ~

O os wmones | |

® o045 Colcumprosprat rbsic

NA  Residuel Spectrum

2 mm NA Composte specium Jodopgs 4 |

@ oss  POWAMDENMONGS
10% GLASS FiER ¥ :

v

3320172,:0262)

el Ll ibetant __________________________________________________________________________________
EXCLUDE RANGE BAR
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Example 4: Raman of Mint Candy.wdf

Action Result
1 | Click New Search. A Windows Open dialog box displays.
2 | Navigate to From the preview, this is not a “good” spectrum.
C:\Users\Public\Documents\Wiley\KnowltAl\Sa
.. . 2 Open R
mples\Optimized Corrections folder.
Look in: Optimized Comections - o ? o r"" -
)_4, Name Date modified Type
Select the spectral file Raman Spectrum of Mint , & IR Spectrum of 2.4-Dinitrotoluene  11/17/2022 1:11 PM  JDX File
Cand df Quick access . .
andy.wdr. Raman Spectrum of Mint Candy.wdf ~ 11/17/2022 1:11 PM  WDF File
l Raman Spectrum of Organic Sample.0 11/17/2022 1:11 PM 0 File
Desktop Raman Spectrum of Plastic.l6s 11/17/2022 1:11 PM  L6S File
Click Open.
m
Libraries
This PC
Network File name: Raman Spectrum of Mint Candy [
Files of type: AllFiles (".") W Cancel

[Jimported spectrum is

T T T
thD 1000 1 be 2000 2500 3000

Encoding: <default> ~
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Action Result
3 | Allow the search to complete, then scroll through We have a very good match.
the Search Status area. EXCLUDE RANGE BAR
Query Status 300000-] - ;MA‘TX #60; D-Sorbitol ‘?;nznea;d ;
prverre P = ingle scan measurement 2 (Corrected)
Noise @ @® @] 250000
Cosmic Rays @ (0] O ‘
(1) Use Computed Spectra 200000
Optimized Corrections 150000~
Baseline of Query, Intensity Distortion, Vertical Clipping,
Horizontal Offset, Vertical Offset, Raman Intensity 100000-1
Distortion \ ﬁ
50000

1 it N

280 4bo” " Tedo 8do” " 10" " 120" T 14oo” T 1600 T 1800 ' 2000 ' 2200° T 2400 ' 2600 ' 2600 ' 3000 ' 3200
D) New Search B

INCLUDE RANGE BAR

Search Status 1-Component Results | Peak Results ‘ Functional Groups ‘

Score ¥/ Infc Name

1-Component Results:

Top Hit: 93.6% 1 9361 D-Sorbitol

2-Component Resuls:
Click to Continue Searching

Classifications:

2 7661 (D Levulinic acid Y\)L‘”‘
$
No Hits Found
3 7439 (D 25-Hexanedione \lA)\
Peak Results:

Top Hit: 782%

Rt 4 7 @ Ehyllewiinate T\)\o/\

21 Functional Groups Found
5 7367 (@ Mucopolysaccarides k
Calcium lactobionate Py
73.1
© T e M Ey
Create Report

4 | If SmartSpectra Raman data is included in one’s

. Query Status

license, one can check “Use Computed Spectra” - _

so that Raman SmartSpectra participates in search  Checdit Status f

and mixture analysis. Noise @ ® 0O
Cosmic Rays . ® O

B use Computed Spectra

Note: From KnowltAll 2025 onwards Cosmic Rays detection is performed and corrected upon the user’s
request.

Deselect Use Computed Spectra for this example.
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Action

Result

5 | Click the @ for Optimized Corrections.

Scroll through the information, the middle of this
page shown on right.

When finished, close out of the pop-up window.

The Raman-specific intensity distortions were corrected by applying an adjustment factor of 60.4% to all regions
above 2474.9 cm™

According to the ASTM E2911-13 Standard Guide for Relative Intensity Correction of Raman Spectrometers, “Generally, Raman spectra measured
using grating-based dispersive or Fourier transform Raman spectrometers have not been corrected for the instrumental response (spectral
responsivity of the detection system). Raman spectra obtained with different instruments may show significant variations in the measured relative
peak intensities of a sample compound. This is mainly as a result of differences in their wavelength-dependent optical transmission and detector
efficiencies. These variations can be particularly large when widely different laser excitation wavelengths are used, but can occur when the same
laser excitation is used and spectra of the same compound are compared between instruments.”

To compensate for these intensity variations when comparing Raman spectra that may not have been corrected for instrumental response, the
following equation introduces an adjustment factor R and is applied to all spectral regions above the wavenumber value mentioned above:

lo=1-(100% - R)

where | is the corrected intensity, and | is the original intensity.

~-] —Corrected

—Uncorrgcted

We see that all kinds of spectrum corrections have been done for the first hit. One unique to KnowltAll is
the “Raman-specific intensity distortion.”
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Action

Result

6 | Go to File > Settings, Optimize Correction tab.

These are the corrections done for Raman sample and reference spectra.

L a

Settings
General Optimized Corrections Databases Classification
Technique:  Raman v

H Optimized Corrections

& Enabled
. Baseline
@ Vertical Clipping
(] Intensity Distortion
B Horizontal Offset
8 Vertical Offset
& Raman Intensity Distortion
i

I Cancel Apply
|

Note on peak clipping: KnowltAll makes a conscious effort to reduce the intensity of the strongest peaks.

7 | As an exercise, you can check off Enabled and
repeat the search to see a very different result.
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Note: In the KnowltAll 2026 release, ID Expert can be run against licensed databases rather than all reference databases. Databases to be
searched can be specified by:

e Going to File > Settings.

e Under the Databases tab, check Search Only License Databases and click on Apply.

Settings
General Optimized Corrections Databases Classification

Technique: Raman e Reset to Default Databases to be Searched... Database Settings...
[ ] Enable User Databases B search Only Licensed Databases

Additional Databases

Available for Searching:

Refresh
& User Name Records DB Code Location
CHSOS 65 CHSOS <|atest Version> I
DEMO_Mlinelt_Classifications 2 DEMOX2 <Latest Version>
LeannaTest1 9 LNE1 <|atest Version>
Michelle 10 5 MMM10 <Latest Version>
|
Add All Add Remove Remove All
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